
ANIUSB-Matrix
Audio Network Interface

Complete user guide for the ANIUSB-MATRIX. Includes system diagrams, specifications, installation instructions, command strings, and 
more.
Version: 8.1 (2024-C)
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ANIUSB-Matrix   
Audio Network Interface

General Description
The ANIUSB-MATRIX Audio Network Interface provides connections for USB, Dante , and analog audio sources. Collaborate 
and connect with all audio devices on a single network, with support for wireless microphones, computers, mobile devices, 
video codecs, and loudspeaker systems. Connect with a single network cable to receive audio and power through Power over 
Ethernet (PoE). Use Shure Designer software to control audio and network settings from any computer connected to the same 
network.

Getting Started
Videoconferencing Room Equipment
Your ANIUSB-MATRIX is one part of a complete room system for videoconferencing. It's helpful to think about all the parts of 
your room system as you get started setting up the ANIUSB-MATRIX.

Medium room equipment example

A standard room includes some or all of this equipment:

Microphone(s)
DSP or other processor
Loudspeakers (networked or analog)

™
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Computer with videoconferencing software
Network switch
Camera
Other accessories such as table mute buttons, tablets to control meetings, and other peripherals

The Microflex
®
 Ecosystem offers a complete portfolio of networked audio solutions that can be precisely tailored to your needs.

What Software Do I Need to Set Up the ANIUSB-MATRIX?
Install this software on a computer that connects to the same network as the ANIUSB-MATRIX:

Control software to adjust ANIUSB-MATRIX settings. This device has 2 options:

Option 1: Shure Designer

Use for managing lots of Shure devices in 1 place
Control Shure devices and route audio between them
Create rooms to manage devices and design coverage

Option 2: Web application (open using Shure Web Device Discovery)

Use to manage each Shure device separately
Control each device individually with its web application
Route audio using Dante Controller

Dante Controller to send audio signals to other Dante devices. Not necessary if you're only routing audio to Shure de­
vices in Designer.
Shure Web Device Discovery to easily find device web applications. Not necessary if you're only using Designer.
Shure Update Utility to update firmware on Shure devices (download at shure.com/suu)

ANIUSB-MATRIX Designer Setup Example
This example uses Shure Designer 6.0 software to set up an ANIUSB­MATRIX and an MXA902. You can use a different micro­
phone with the ANIUSB-MATRIX, but the setup process in Designer is similar.

After completing this basic setup process, you should be able to:

Access the ANIUSB-MATRIX in Designer
Adjust settings and route audio
Understand the basic workflow for working with devices in Designer

This example uses:

Cat5e or better Ethernet cable (shielded cable recommended)
Network switch that provides Power over Ethernet Plus (PoE+)
Shure Designer software (download at shure.com/designer)
MXA902
Computer with videoconferencing software

For best results, route 1 microphone to the ANIUSB-MATRIX. If using multiple microphones in a space, use a device with an 
automixer (such as a P300 or IntelliMix  Room

®
).

https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
http://www.shure.com/designer
https://www.shure.com/en-US/products/software/shure_web_device_discovery_application
https://www.audinate.com/products/software/dante-controller
https://www.shure.com/suu
https://www.shure.com/designer
https://www.shure.com/en-US/products/mixers/p300?variant=P300-IMX
https://www.shure.com/en-US/products/software/intellimix_room
https://www.shure.com/en-US/products/software/intellimix_room
https://www.shure.com/en-US/products/software/intellimix_room
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Step 1: Install and Connect

Install the ANIUSB­MATRIX and other devices. Connect the MXA902 to a PoE+ port on the network switch using Ether­
net cable. If your switch doesn't supply PoE+, the loudspeaker does not play sound and the error LED flashes. The 
ANIUSB-MATRIX only requires PoE.
Connect a computer with videoconferencing software (such as Zoom or Microsoft Teams) installed on it to the ANIUSB-
MATRIX's USB port.
Connect the computer running Designer to the same network.
Open Designer. Check that you’re connected to the correct network in File > Designer preferences.
Open a new design and drag both devices into the design.

Step 2: Route Audio and Apply DSP
The easiest way to route audio and apply DSP is with Designer's auto route workflow. This feature routes audio signals, applies 
DSP settings, turns on mute synchronization, and enables LED control for connected devices.

Select Auto route. Designer makes the following routes:
MXA902 to ANIUSB-MATRIX
ANIUSB-MATRIX USB output to computer with videoconferencing software
ANIUSB-MATRIX Dante output to MXA902 Dante input (loudspeaker)

You can also route audio manually in Designer or use Dante Controller.

Check the audio routes, matrix mixer routes, and other settings to make sure they fit your needs. To adjust matrix mixer 
routes, go to [Your room] > ANIUSB-MATRIX > Matrix mixer.
Select Deploy and connect to send the settings to the installed devices. Designer walks you through associating the de­
sign devices with the online devices.
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Step 3: Listen and Adjust
Open the videoconferencing software on the computer connected to the ANIUSB-MATRIX. In the settings, choose the 
ANIUSB-MATRIX as the speaker and microphone.
Place a test call with the whole system. Have the far-end caller tell you how the microphone signal sounds and make 
adjustments as needed:

Microphone: [Your room] > MXA902 > IntelliMix
Loudspeaker: [Your room] > MXA902 > Loudspeaker > Speaker output.
ANIUSB-MATRIX: [Your room] > ANIUSB-MATRIX

If needed, move the microphone's coverage area: [Your room] > Coverage. You can also listen to the microphone 
signal directly using a Dante headphone amp to help make adjustments.

ANIUSB-MATRIX Parts

The LEDs on the front of the ANIUSB-MATRIX behave the same as the ones on the back of the device.

Sig/clip level indicators

Tri­color LEDs indicate the audio signal level for the analog channels and connectivity status for the USB channel. Ad­
just output levels in Shure Designer software to avoid clipping.

Sig/Clip In and Out LED Behavior

LED State Audio Signal Level

Off Less than −60 dBFS

Green −59 dBFS to −24 dBFS

Yellow −23 dBFS to −1 dBFS

Red 0 dBFS or more

Note: The input and output LEDs are off when metering is set to post-gain.

USB Audio LED Behavior

LED State Meaning

Off No USB device connected

Green USB device operating successfully

https://service.shure.com/s/article/dante-headphone-amplifier
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LED State Meaning

Red (flashing) Problem detected with connected USB audio device

Audio input (block connector)

Block pin assignments:

+ : Audio +
− : Audio −
Ground symbol: Audio ground

Chassis ground screw

Provides an optional connection for microphone shield wire to chassis ground.

Audio output (block connector)

Balanced audio output connects to an analog device. Set the output level in Shure Designer software to match the input 
sensitivity of the analog device.

Note: See front panel labels for block connector assignments.

USB port

Connects to a computer to send and receive any combination of input and output audio channels.

Power LED

On when device has PoE

Network LED

On when network connection is active

Network audio LED

Network Audio LED Behavior

LED State Meaning

Off No active signal.

Green Device is operating successfully.

Red
Error has occurred. Refer to event log in web application 
for details.

Encryption LED

Encryption LED Behavior

LED State Meaning

Off Audio is not encrypted

Green
Successful encrypted audio connection with another de­
vice

Red
Encryption error. Possible causes:
Encryption is enabled on one device and not on another
Encryption passphrase mismatch
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RJ-45 network port
Reset button

Network reset (press button for 4­8 seconds): Resets all Shure control and audio network IP settings to factory de­
faults
Full factory reset (press button for longer than 8 seconds): Restores all network and Designer settings to the facto­
ry defaults

Power Over Ethernet (PoE)
This device requires PoE to operate. It is compatible with both Class 0 and Class 3 PoE sources.

Power over Ethernet is delivered in one of the following ways:

A network switch that provides PoE
A PoE injector device

What's in the Box
KIT, HARDWARE, ANIUSB-MATRIX 90A33522

Mounting Bracket (1/3 rack unit) 53A27742

Note: USB cable not included.

Control Devices with Shure Designer Software
To control this device's settings, use Shure Designer software. Designer enables integrators and system planners to design au­
dio coverage for installations using MXA microphones and other Shure networked devices.

To access your device in Designer:

Download and install Designer on a computer connected to the same network as your device.
Open Designer, and check that you’re connected to the correct network in File > Designer preferences.
Click Online devices. A list of online devices appears.
To identify devices, select a device and click ID in the Properties menu. Double-click the device to open the settings.

From here, you can add devices to designs or online rooms and route audio to other Shure devices. Learn more at shure.com/
designer.

You can also access device settings using Shure Web Device Discovery.

Use Designer's Auto Route
Designer's auto route speeds up the process of connecting systems with 1 audio processor and at least 1 microphone. Auto 
route also creates mute control routes in rooms with MXA network mute buttons. When you select Auto route, you can direct 
Designer to:

Create audio routes and mute control routes
Adjust audio settings
Turn on mute synchronization
Enable LED logic control for applicable devices

http://www.shure.com/designer
http://www.shure.com/designer
https://www.shure.com/en-US/products/software/shure_web_device_discovery_application
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The settings are optimized for your particular combination of devices. You can adjust settings further, but auto route gives you a 
good starting point. Auto route works with any device in Designer.

To use auto route:

Place all relevant devices in a design.
Select Auto route. Designer optimizes microphone and DSP settings for your equipment combination.

If you remove or add devices, select Auto route again.

Note: The auto route process clears any manual routes you may have made in your design.

After auto routing a room, check and adjust settings to fit your needs. You may need to:

Delete unnecessary routes.
Check levels and adjust gain.
Check that AEC reference signals are correctly routed and received in a test call.
Fine-tune DSP blocks.
Adjust your processor's matrix mixer routes.

If you want to auto route an online room, turn on online room editing in File > Designer preferences.

Note: Changes to an online room may cause audio to briefly drop out.

Refer to Designer's Troubleshooting section for help with routing.

Installation and Rack Mounting
Two mounting solutions are available for installing the Audio Network Interface:

CRT1 19" Rack Tray (optional accessory): Supports up to 3 devices; mountable in a rack or under a table

Single-unit Mounting Tray (included accessory): Supports a single device for mounting under a table

Securing the Devices
Use the included screws from the mounting hardware kit to secure the Audio Network Interfaces. Audio Network Interfaces can 
be mounted to face either direction. Insert the screws from the bottom in the appropriate holes, according to the following dia­
grams:

Align the holes as shown for securing a single device in the single-unit mounting tray

https://pubs.shure.com/guide/Designer/en-US#c_07601b9f-5da8-414d-a01b-9f5da8214d19
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Align the holes as shown for securing up to 3 devices in the 19" rack tray.

Rack Ear Configuration
A combination of up to 3 Audio Network Interfaces can be mounted in a single 19-inch rack space. The adjustable rack ears 
support mounting in a standard equipment rack or underneath a table.

Standard 19" Rack Mount
Align the ears with the mounting holes pointed forward.
Install the 3 screws that hold the ear to the tray as shown.

Under-Table Mounting
Align the ears with the mounting holes pointed upward.
Install the 3 screws that hold the ear to the tray as shown.
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Installing Underneath a Table
Hold the tray in the desired location under a table.
Use a pencil to mark the location of the mounting holes on the table.
Drill 4 holes for the screws. The diameter of the holes in the tray are 7.1 mm.
Install the components into the tray.
Install with 4 screws to secure the tray underneath the table.

Connections and Signal Flow
The ANIUSB-MATRIX has 4 Dante inputs and 2 Dante outputs. You can route any input to any output and adjust crosspoint 
gain using the matrix mixer.

The ANIUSB-MATRIX has 2 Dante transmit flows. Learn more about Dante flows.

Best Practices
For best results, route 1 microphone to the ANIUSB-MATRIX. If using multiple microphones in a space, use a device with 
an automixer (such as a P300 or IntelliMix Room).
Use Shure Designer's auto route workflow to quickly set up Dante audio routes, mute control routes, matrix mixer routes, 
and other settings.

These are some of the devices that you can connect to the ANIUSB-MATRIX:

https://www.shure.com/en-US/products/mixers/p300?variant=P300-IMX
https://www.shure.com/en-US/products/software/intellimix_room
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1. Computer with videoconferencing software
The computer sends and receives audio to and from the videoconferencing software. All signals pass through the ANIUSB-
MATRIX's USB connection. Route Dante sources using Shure Designer or Dante Controller software.

Note: Compatible with Mac and PC

2. Analog input sources
Analog sources (such as wireless microphones or any line-level devices) connect to the analog line input.

3. Analog output devices
Loudspeakers, amplifiers, or recording devices connect to the analog line output.

4. Dante-enabled microphone
A Dante microphone (such as a Shure Microflex Advance array) connects to the network switch. Route the microphone's 
signal to the ANIUSB-MATRIX, and then use the matrix mixer to route the signal to the USB output.

5. Control computer
A computer connected to the network accesses Shure Designer to control the channel levels and processing.

6. Network switch
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The network switch provides Power over Ethernet (PoE) to devices that require it.

Connecting the ANIUSB-MATRIX to a Computer
Connect the ANIUSB-MATRIX to a computer with conferencing software using the USB port.

When the ANIUSB-MATRIX is connected for the first time, the computer recognizes it as a USB audio device. You may need to 
select it as the input/output (recording/playback) device to pass audio. Assign the ANIUSB­MATRIX as the default device to en­
sure it passes audio every time it is plugged in. Refer to the manual for your computer to configure the audio settings.

Routing Audio Channels to the USB Port
You can route audio to and from the ANIUSB using Dante Controller or Shure Designer software. Use the ANIUSB's matrix 
mixer to route Dante and analog channels to the USB port.

Step 1: Dante Controller or Shure Designer

Open Dante Controller or Shure Designer and route Dante devices (such as MXA or MXW microphones) to the 
ANIUSB's Dante input channels. Name the channels to keep track of devices.
If you need to send channels from the ANIUSB to other Dante-enabled devices (such as an amplifier, loudspeaker, or 
recording device), route the ANIUSB's Dante output channels to the appropriate devices in Dante Controller.

Note: Shure Designer creates Dante audio routes between Shure devices. To create Dante audio routes with non-Shure Dante devices, use Dante 
Controller.

Step 2: Matrix mixer

Open the ANIUSB's matrix mixer to route Dante and analog channels to the USB port.
Assign the USB Input channel (far-end audio) to the appropriate outputs. If recording a meeting, be sure to route the 
near-end microphones and the USB input to the recording device.

Adapter Compatibility
This device is compatible with USB­B to USB­C adapters. Using an adapter is only recommended for desktop and laptop com­
puters, as many mobile devices do not support bi-directional audio through USB or lightning ports.

USB Device Type Settings
When you use a USB-connected codec with a P300 or ANIUSB-MATRIX, you may need to set the USB device type on the 
Shure device.

The USB device type setting tells the codec if acoustic echo cancellation (AEC) is needed or not. The codec can then turn on 
or turn off its own AEC (if supported).

For example: You have an MXA710 routed to an ANIUSB-MATRIX and want to use the MXA710's AEC. Set the USB device 
type to Echo­canceling speakerphone to tell the codec to turn off its AEC.

To change USB device type:

In Designer, find the P300 or ANIUSB-MATRIX and go to Settings > General.
Choose a USB device type:

Speakerphone: For using the codec’s AEC
Echo­canceling speakerphone: For using the Shure device’s AEC

After changing the USB device type, select your device as the default audio device in the codec’s settings.
Place a test call to make sure AEC is working properly.
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Mute Sync
It’s important to be able to see if a room is muted or unmuted during a call. You want devices to show the same mute status as 
the videoconferencing software. Shure devices use logic and mute sync to make this happen.

Logic: Aligns mute status across Shure devices in the room. The processor (such as a P300, IntelliMix Room software, or 
an ANIUSB-MATRIX) is the controller.
Mute sync: Aligns mute between the processor and the videoconferencing software, which is on a computer connected to 
the processor by USB. The processor’s automix output is muted or unmuted to change the mute status of the system.

When mute sync is working correctly, you can mute a device (mute button or microphone mute button) or the videoconferenc­
ing software to mute the room.

To use mute sync:

In Designer, create audio and mute control routes between devices in the room.
Connect a computer with videoconferencing software to the processor's USB port.
Turn on mute sync and logic:

Processors: [Your device] > Settings > Mute control
Microphones without physical mute button: Logic is always on
MXA310 and MXA mute button: Settings > Logic control > Mute control function > Logic out

Designer's auto route process configures all necessary mute sync and logic settings for you.

Compatible Shure Logic Devices
P300 (Also mutes supported soft codecs connected by USB)
ANIUSB-MATRIX (Also mutes supported soft codecs connected by USB)
IntelliMix Room software (Also mutes supported soft codecs connected by USB)
MXA901
MXA902
MXA910
MXA920
MXA710
MXA310
Network Mute Button
ANI22-BLOCK
ANI4IN-BLOCK
Logic-enabled MX microphones connected to ANI22-BLOCK or ANI4IN-BLOCK

MX392

https://www.shure.com/en-US/products/mixers/p300
https://www.shure.com/en-US/products/mixers/aniusb-matrix
https://www.shure.com/en-US/products/software/intellimix_room
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MX395-LED
MX396
MX405/410/415

For help with specific mute sync implementations, see our FAQs.

Audio Settings
Schematic View
The schematic view in Designer provides an overview of the entire audio signal chain, with the ability to adjust settings and 
monitor signals.

Adjusting Settings
Right-click an input, output, or processing block to access the following options:

Channel Settings

Setting Function

Copy / paste

Copy and paste settings between items. For example, set 
the equalizer curve on the USB output, and then use the 
same setting for the analog output. Or, copy the gain and 
mute status from one input channel to several others.

Mute / unmute Mutes or activates the channel

Enable / disable
Turns processing on or off (does not apply to matrix mixer or 
automixer)

Edit
Opens the dialog to adjust parameters. You can also double-
click a block to edit it.

Right-click in a blank area to access global settings:

Mute/unmute all input channels
Mute/unmute all output channels
Close all open dialogs

Customizing the Workspace
Create a custom environment to monitor and control a set of inputs, outputs, and processing blocks from a single screen. 
There are 2 ways to break out dialogs:

Right-click  >  Edit
Double-click the input, output, or processing block.

Open as many dialogs as you need to keep important controls available.

Metering and DSP Blocks
A meter appears underneath each input and output to indicate signal levels (dBFS).

https://www.shure.com/americas/support/find-an-answer
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DSP blocks have a color when they are turned on. When off, they are gray. Use these tools to troubleshoot audio signals and 
verify connections and levels.

Mute and Fader Groups

Mute Groups
Check the Mute group box to add the channel to a group. Muting any channel within the 
Mute group mutes all channels in the group.

Fader Groups
Check the Fader group box to add the channel to a group. All faders within the group are 
linked, and move together when a single fader is adjusted.

Adjusting Input levels
Levels for analog and Dante channels are adjustable in the Input tab.

To monitor input levels before they reach the ANIUSB-MATRIX, set the metering to Pre-gain in the Settings menu. When ad­
justing the faders, set metering to Post-gain.

Dante Sources
Check the source level before it reaches the Network Interface:

Verify that the networked microphones or other Dante sources are operating at nominal output levels.
Adjust levels for MXA microphones in Designer.

Adjust the digital gain in Designer:
Use the faders or manually enter a gain value.
The digital gain adjusts the level of the signal before it reaches the matrix mixer.
Mix the levels as high as possible without the loudest channel reaching the peak level (0 dB) on the meter.

Note: The matrix mixer provides crosspoint gain, to adjust separate submixes for different outputs.

Analog Sources
Before you begin, verify that levels from the analog devices with adjustable output levels are operating at nominal levels. The 
fader adjusts the digital gain before the signal reaches the matrix mixer.

Match the analog input level setting according to the incoming signal level:

Line: (+4 dBu)

Aux: (-10 dBV)

Use the fader (digital gain) to adjust the mix going to the USB or Dante output channels.

Adjusting Output Levels
Tip: Set the metering to post-fader in the settings menu to adjust output levels.

Adjust faders in the Outputs section as high as necessary, but make sure to avoid clipping (when the signal reaches 0 dBFS). 
Always adjust the input gain and crosspoint gain in the matrix mixer before the output gain.

Analog output level:Select Line, Aux, or Mic level output signal to match the sensitivity of the receiving device.

Parametric Equalizer
Maximize audio quality by adjusting the frequency response with the parametric equalizer.
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Common equalizer applications:

Improve speech intelligibility
Reduce noise from HVAC systems or video projectors
Reduce room irregularities
Adjust frequency response for reinforcement systems

Setting Filter Parameters
Adjust filter settings by manipulating the icons in the frequency response graph, or by entering numeric values. Disable a filter 
using the checkbox next to the filter.

PEQ Filter Settings

Setting Function

Filter Type

Only the first and last band have selectable filter types.

Parametric: Attenuates or boosts the signal within a cus­
tomizable frequency range
Low Cut: Rolls off the audio signal below the selected fre­
quency
Low Shelf: Attenuates or boosts the audio signal below the 
selected frequency
High Cut: Rolls off the audio signal above the selected fre­
quency
High Shelf: Attenuates or boosts the audio signal above the 
selected frequency

Frequency Select the center frequency of the filter to cut or boost

Gain Adjusts the level for a specific filter (+/− 18 dB)

Q
Adjusts the range of frequencies affected by the filter. As this 
value increases, the bandwidth becomes thinner.

Width

Adjusts the range of frequencies affected by the filter. The 
value is represented in octaves.

Note: The Q and width parameters affect the equalization curve in the same 
way. The only difference is the way the values are represented.
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Copy and Paste Equalizer Channel Settings
Use to quickly apply the same PEQ setting across multiple channels.

Select the PEQ of the desired channel.
Click copy.
Select the channel to apply the PEQ setting to and click paste.

Equalizer Applications
Conferencing room acoustics vary based on room size, shape, and construction materials. Use the guidelines in following ta­
ble.

Uses for EQ

EQ Application Suggested Settings

Treble boost for improved speech intelligibility
Add a high shelf filter to boost frequencies greater than 1 
kHz by 3-6 dB

HVAC noise reduction Add a low cut filter to attenuate frequencies below 200 Hz
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EQ Application Suggested Settings

Reduce flutter echoes and sibilance

Identify the specific frequency range that "excites" the room:

Set a narrow Q value.
Increase the gain to between +10 and +15 dB, and 
then experiment with frequencies between 1 kHz and 
6 kHz to pinpoint the range of flutter echoes or sibi­
lance.
Reduce the gain at the identified frequency (start be­
tween −3 and −6 dB) to minimize the unwanted room 
sound.

Reduce hollow, resonant room sound

Identify the specific frequency range that "excites" the room:

Set a narrow Q value.
Increase the gain to between +10 and +15 dB, and 
then experiment with frequencies between 300 Hz 
and 900 Hz to pinpoint the resonant frequency.
Reduce the gain at the identified frequency (start be­
tween −3 and −6 dB) to minimize the unwanted room 
sound.

Custom Presets
Use presets to quickly save and recall settings. Up to 10 presets can be stored on each device to match various seating 
arrangements. A preset saves all device settings except for the Device Name, IP Settings, and Passwords. Importing and ex­
porting presets into new installations saves time and improves workflow. When a preset is selected, the name displays above 
the preset menu. If changes are made, an asterisk appears next to the name.

Note: Use the default settings preset to revert to the factory configuration (excludes Device Name, IP Settings, and Passwords).

Open the presets menu to reveal preset options:

save as preset: Saves settings to the device

load preset: Opens a configuration from the device

import from file:
Downloads a preset file from a computer onto the device. Files may be selected through the 
browser or dragged into the import window.

export to file: Saves a preset file from the device onto a computer

Matrix Mixer
The matrix mixer routes audio signals between inputs and outputs for simple and flexible routing:

Send a single input channel to multiple outputs
Send multiple input channels to a single output
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Crosspoint Gain
Crosspoint gain adjusts the gain between a specific input and output, to create separate submixes without changing input or 
output fader settings. Select the dB value at any crosspoint to open the gain adjustment panel.

Gain staging: Input fader > crosspoint gain > output fader

Routing Channels
Connect inputs and outputs by selecting the box where they intersect.

ANIUSB-MATRIX Default Routes
The matrix mixer creates these default routes. Adjust them to fit your needs.

Use Call Status
Designer's call status feature uses microphone LEDs to show if you're in a videoconferencing call or not. This is a room-level 
feature, so it applies to all microphones in the same Designer room.

To use call status:

Put all microphones and processors (ANIUSB-MATRIX, IntelliMix Room, or P300) in the same Designer room.
Select Auto route to create audio and mute control routes. You can also route audio manually.
Go to [Your room] > Settings > Call status to turn on call status.

When call status is on:

Microphone LEDs off = Not in a call
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Microphone LEDs on = In a call

Call status is compatible with the following codecs:

Microsoft Teams
Microsoft Teams Rooms
Zoom Client for Meetings
Zoom Rooms

Note: If your codec is running on a computer with a Chrome operating system, call status will not work.

Encryption
Audio is encrypted with the Advanced Encryption Standard (AES-256), as specified by the US Government National Institute of 
Standards and Technology (NIST) publication FIPS-197.

Encryption is not supported with third-party devices.

Important: For encryption to work:

Devices must be online and support encryption.
Encryption must be turned on for all devices in the room.
You must disable AES67 in Dante Controller. AES67 and AES-256 can't be used at the same time.

To turn on encryption:

In an online room, select  > Audio encryption > Turn on encryption. You can auto generate a key or enter one 
manually.

To re-key or turn off encryption:

In an online room, select  > Audio encryption and enter any passwords.

Set Up the 802.1X Protocol for a Device
Select Shure devices support the IEEE 802.1X port access protocol for network authentication.

Important: To use the 802.1X security protocol with Shure devices, set the network switch to multiple host authentication. You 
must also make accommodations to allow the audio network interface to connect to the network. The audio network interface 
doesn't support the 802.1X protocol.

Setting up 802.1X is a two-part process.

To set up 802.1X, you will need:

Details about your authentication server's EAP method
Any required credentials or certificates for that method, for example:

MD5 and PWD
User ID and passphrase

TLS and PEAP
User ID and passphrase
Certificate (with certificate types) in the .PEM format

Any passwords to access the devices if they are password locked
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Step 1: Configure Settings on Test Network
Connect the device to your test network and discover it using Designer.
Initialize the device if necessary. Open the device and go to Settings > Network > 802.1X.
Choose your EAP method from the menu.
Enter any required credentials and load any necessary certificates.
Press Save to save the 802.1X settings to the device.
Enable 802.1X and select Reboot later.

Step 2: Connect to a Credentialed Network
Connect your device to the credentialed network.
Ensure that Designer is connected to the credentialed network.
Go to Settings > Network > 802.1X and enable 802.1X. Reboot the device for the 802.1X settings to take effect.
If the device doesn’t appear in Designer after the reboot, reconnect to the test network and check all 802.1X settings for 
the selected EAP method.

Turn Off or Clear 802.1X Settings
You can turn off 802.1X settings temporarily, or clear them from the device. Open the device and go to Settings > Network
> 802.1X

Disable: Click the 802.1X switch to turn off 802.1X settings. Click the switch again to enable 802.1X.
Clear: Click Clear 802.1X settings to remove 802.1X settings from the device.

Note: Resetting to factory default clears all 802.1X settings.

Change 802.1X Settings
You may need to change a device’s 802.1X settings if the enterprise’s 802.1X settings are changing. The best way to do this is 
to change the 802.1X settings on the devices, and then make changes to the authentication server.

To change device settings:

While still connected to the credentialed network, find the device in Designer and go to Settings > Network > 
802.1X.
Make changes and click Save.
Make any changes to the authentication server.
Reboot your devices. The devices should connect to the credentialed network with the updated 802.1X settings.

Troubleshooting 802.1X Setup Issues
If the device doesn’t appear in Designer on the credentialed network, there’s a problem with the device’s 802.1X settings. To 
troubleshoot, take the device off the credentialed network and connect it to the test network. You can make any necessary 
changes to the 802.1X settings, and then reconnect to the credentialed network.

If you attempt to enable 802.1X on a device, but the authentication fails, you will see this notification:

If this occurs, check with your system administrator.
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Networking and Dante
Switch and Cable Recommendations for Dante Networking
Switches and cables determine how well your audio network performs. Use high­quality switches and cables to make your au­
dio network more reliable.

Network switches should have:

Gigabit ports. 10/100 switches may work on small networks, but gigabit switches perform better.
Power over Ethernet (PoE) or PoE+ ports for any devices that require power
Management features to provide information about port speed, error counters, and bandwidth used
Ability to switch off Energy Efficient Ethernet (EEE). EEE (also known as "Green Ethernet") may cause audio dropouts and 
problems with clock synchronization.
Diffserv (DSCP) Quality of Service (QoS) with strict priority and 4 queues

Ethernet cables should be:

Cat5e or better
Shielded

For more information, see our FAQ about switches to avoid.

Dante Flows for Shure Devices
Dante flows get created any time you route audio from one Dante device to another. One Dante flow can contain up to 4 audio 
channels. For example: sending all 5 available channels from an MXA310 to another device uses 2 Dante flows, because 1 
flow can contain up to 4 channels.

Every Dante device has a specific number of transmit flows and receive flows. The number of flows is determined by Dante 
platform capabilities.

Dante Flows for Shure Devices

Dante Platform
Shure Devices Using Plat-
form

Transmit Flow Limit Receive Flow Limit

Brooklyn II
ULX-D, SCM820, MXWAPT, 
MXWANI, P300, MXCWAPT

32 32

Brooklyn II (without SRAM)
MXA920, MXA910, MXA902, 
MXA710, AD4, AD600, 
APXD2

16 16

IP Core
MXA920-V3, MXA902-V3, 
MXA901

32 32

Ultimo/UltimoX
MXA310, ANI4IN, ANI4OUT, 
ANIUSB-MATRIX, ANI22, 
MXN5-C

2 2

DEP ANIUSB-MATRIX-V3 2 2

DAL IntelliMix Room 16 16

Learn more about Dante flows in our FAQs or from Audinate.

https://service.shure.com/s/article/disqualified-network-switches-for-shure-dante-devices?language=en_US
https://www.shure.com/en-US/support/find-an-answer/understanding-dante-flows
https://www.audinate.com
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Pushing Names to the Dante Network
You can edit device and channel names by double-clicking on the device. You can also edit the device name on the routing 
page or in the properties panel.

To send Designer device and channel names to Dante Controller, double-click on a device and go to Settings > General, 
then select Push to Dante. You can also push these names to Dante when you deploy.

Note: Names appear in Dante Controller with "-d" attached.

Compatibility with Dante Domain Manager
This device is compatible with Dante Domain Manager software (DDM). DDM is network management software with user au­
thentication, role-based security, and auditing features for Dante networks and Dante-enabled products.

Considerations for Shure devices controlled by DDM:

When you add Shure devices to a Dante domain, set the local controller access to Read Write. Otherwise, you won't be 
able to access Dante settings, perform a factory reset, or update device firmware.
If the device and DDM can't communicate over the network for any reason, you won't be able to control Dante settings, 
perform a factory reset, or update device firmware. When the connection is reestablished, the device follows the policy set 
for it in the Dante domain.
If Dante device lock is on, DDM is offline, or the configuration of the device is set to Prevent, some device settings are dis­
abled. These include: Dante encryption, MXW association, AD4 Dante browse and Dante cue, and SCM820 linking.

Refer to Dante Domain Manager's documentation for more information.

Note: Applies to firmware 4.1.x and newer.

Change IP Settings
You can change IP configurations in Shure Designer. By default, they are set to Automatic (DHCP). DHCP enables a device to 
accept IP settings from a DHCP server, or automatically fall back to link­local settings when no DHCP is available. IP address­
es may also be manually set.

To change IP configurations:

Open Designer and go to [Your room] > [Device] > Settings > IP configuration.
Select Auto or Manual. If Auto is used, addresses will be automatically assigned.
For Manual, enter the IP settings.

Setting Latency
Latency is the amount of time for a signal to travel across the system to the outputs of a device. To account for variances in la­
tency time between devices and channels, Dante has a predetermined selection of latency settings. When the same setting is 
selected, it ensures that all Dante devices on the network are in sync.

These latency values should be used as a starting point. To determine the exact latency to use for your setup, deploy the set­
up, send Dante audio between your devices, and measure the actual latency in your system using Audinate's Dante Controller 
software. Then round up to the nearest latency setting available, and use that one.

Use Audinate's Dante Controller software to change latency settings.

Latency Recommendations
Latency Setting Maximum Number of Switches

0.25 ms 3

0.5 ms (default) 5

https://audinate.com/
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Latency Setting Maximum Number of Switches

1 ms 10

2 ms 10+

IP Ports and Protocols

Shure Control

Port TCP/UDP Protocol Description
Factory De-
fault

21 TCP FTP Required for firmware updates (otherwise closed) Closed

22 TCP SSH Secure Shell Interface Closed

23 TCP Telnet Not supported Closed

53 UDP DNS Domain Name System Closed

67 UDP DHCP Dynamic Host Configuration Protocol Open

68 UDP DHCP Dynamic Host Configuration Protocol Open

80* TCP HTTP Required to launch embedded web server Open

443 TCP HTTPS Not supported Closed

2202 TCP ASCII Required for 3rd party control strings Open

5353 UDP mDNS Required for device discovery Open

5568 UDP SDT (multicast) Required for inter-device communication Open

57383 UDP SDT (unicast) Required for inter-device communication Open

8023 TCP Telnet Debug console interface Closed

8180 TCP HTML Required for web application (legacy firmware only) Open

8427 UDP SLP (multicast) Required for inter-device communication Open

64000 TCP Telnet Required for Shure firmware update Open

*These ports must be open on the PC or control system to access the device through a firewall.

These protocols require multicast. Ensure multicast has been correctly configured for your network.

See Audinate's website for information about ports and protocols used by Dante audio.

†

†

†

†

https://www.audinate.com/learning/faqs/which-network-ports-does-dante-use
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Using Command Strings
This device receives logic commands over the network. Many parameters controlled through Designer can be controlled using 
a third-party control system, using the appropriate command string.

Common applications:

Mute
LED color and behavior
Loading presets
Adjusting levels

A complete list of command strings is available at:

pubs.shure.com/command-strings/ANIUSB-Matrix.

Reset
The reset button is located inside a small hole in the rear panel. Use a paperclip or other small tool to press the button.

There are two hardware reset functions:

Network reset (press button for 4-8 seconds)
Resets all Shure control and audio network IP settings to factory defaults

Full factory reset (press button for longer than 8 seconds)
Restores all network and Designer settings to the factory defaults.

Software Reset Options
To simply revert settings without a complete hardware reset, use one of the following options:

Reboot Device:Power-cycles the device as if it were unplugged from the network. All settings are retained when the device is 
rebooted.

Default Settings: To revert audio settings back to the factory configuration (excluding Device Name, IP Settings, and Pass­
words), select Load Preset and choose the default settings preset.

Troubleshooting
Problem Solution

Software lags in Google Chrome browser
Problem is browser-related. Turn off hardware acceleration 
option in Chrome.

Sound quality is muffled
Use equalizer to adjust frequency response. See the equal­
izer applications for the appropriate use.

Audio sounds too high or too low in pitch
Make sure that the sample rate settings for Playback and 
Recording are the same in your computer's sound settings. If 

https://pubs.shure.com/command-strings/ANIUSB-Matrix
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Problem Solution

these sample rates do not match, the audio may sound too 
high or too low in pitch.

Hardware does not show up in device discovery

Ensure the devices are powered
Ensure PC and equipment are on the same network and set 
to the same subnet
Turn off other network interfaces not used to connect to the 
device (including WiFi)
Check that DHCP server is functioning (if applicable)
Reset the device

No audio

Verify the ANIUSB-MATRIX is selected as the audio device 
in the audio devices or properties panel on the computer
Audio channels must be routed to an output through the ma­
trix mixer
Connections between devices must be established in Dante 
Controller  software
Check cables
Verify that input/output channels are not muted
Check that fader levels are not set too low
Make sure there is not an encryption error -- a passphrase 
mismatch or encryption only enabled on one device disrupts 
audio.

Cannot route Dante audio channels
Install latest version of Dante Controller from Audinate , 
available at www.audinate.com.

Hardware does not power on
The network switch must supply Power over Ethernet. Other­
wise, a PoE injector must be used
Check network cables and connections

Event Log
The event log provides a detailed account of activity from the moment the device is powered on. The log collects up to 1,000 
activity entries and time-stamps them relative to the last power cycle. The entries are stored in the internal memory and are not 
cleared when the device is power-cycled. The export feature creates a CSV (comma separated values) file to save and sort the 
log data.

Refer to the log file for details when troubleshooting or when working with Shure support.

To view the event log:

Open the device's web application. As of Designer 6 and newer, there is no longer an event log in Designer.
Select Help > View event log.

Severity Level

Information
An action or event has been successfully completed

™

®
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Warning
An action cannot be complete, but overall functionality is stable

Error
A problem has occurred that could inhibit functionality.

Log Details

Description
Provides details on events and errors, including IP address and subnet mask.

Time Stamp
Power cycles:days:hours:minutes:seconds since most recent boot-up.

Event ID
Indicates event type for internal reference.

Tip: Use the filter to narrow down results. Select a category heading to sort the log.

Specifications
General

Analog Connections
Input (1) 3-pin block connector (Active Balanced)

Output (1) 3-pin block connector (Impedance Balanced)

USB Connections
(1) USB 2.0, Type B

Single port carries 1 input and 1 output channel (Summed mono)

Network Connections (Dante Digital Audio)
(1) RJ45

4 input channels, 2 output channels

Polarity
Non-inverting, any input to any output

Power Requirements
Power over Ethernet (PoE), Class 0. (PoE Plus compatible).

Power Consumption
6.5W, maximum

Weight
668  g (1.5 lbs)
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Dimensions
H x W x D

4 x 14 x 12.8 cm ( 1.6 x 5.5 x 5.0 in.)

Control Software
Shure Designer

Operating Temperature Range
−6.7°C (20°F) to 40°C (104°F)

Storage Temperature Range
−29°C (­20°F) to 74°C (165°F)

Thermal Power Dissipation
Maximum 6.8W ( 23.0BTU/hr)

typical 6.0W ( 20.8BTU/hr)

Audio

Frequency Response
+1, -1.5  dB

20 to 20,000 Hz

Dante Digital Audio
Sampling Rate 48 kHz

Bit Depth 24

USB Audio
Sampling Rate 48 kHz

Bit Depth 16, 24

Latency

Does not include Dante latency

Analog to Analog 0.98 ms

Analog to Dante 0.39 ms

Dante to Analog 0.72 ms

Dante to Dante 0.14 ms

Dynamic Range
20 Hz to 20 kHz, A-weighted, typical

Analog-to-Dante 113 dB

Dante-to-Analog 117 dB

Equivalent Input Noise
20 Hz to 20 kHz, A-weighted, input terminated with 150Ω
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Line ­86 dBV

Aux ­98 dBV

Total Harmonic Distortion
@ 1 kHz, 0 dBV Input, 0 dB analog gain

<0.05%

Common Mode Rejection Ratio
150Ω balanced source @ 1 kHz

>70 dB

Impedance
10.6 kΩ

Input Clipping Level
Line +27 dBV

Aux +15 dBV

Output Clipping Level
Line +20 dBV

Aux +0 dBV

Mic ­26 dBV

Built-in Digital Signal Processing
Per Channel Equalizer (4­band Parametric, Analog and USB output channels only) , Mute, Limiter, Gain ( 140 dB range)

System Matrix mixer

Networking

Cable Requirements
Cat 5e or higher (shielded cable recommended)

Optional Accessories and Replacement Parts
19" rack tray CRT1

Safety Information
IMPORTANT SAFETY INSTRUCTIONS

READ these instructions.
KEEP these instructions.
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HEED all warnings.
FOLLOW all instructions.
DO NOT use this apparatus near water.
CLEAN ONLY with dry cloth.
DO NOT block any ventilation openings. Allow sufficient distances for adequate ventilation and install in accordance 
with the manufacturer’s instructions.
DO NOT install near any heat sources such as open flames, radiators, heat registers, stoves, or other apparatus (in­
cluding amplifiers) that produce heat. Do not place any open flame sources on the product.
DO NOT defeat the safety purpose of the polarized or grounding type plug. A polarized plug has two blades with one 
wider than the other. A grounding type plug has two blades and a third grounding prong. The wider blade or the third 
prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replace­
ment of the obsolete outlet.
PROTECT the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.
ONLY USE attachments/accessories specified by the manufacturer.
USE only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a 
cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

UNPLUG this apparatus during lightning storms or when unused for long periods of time.
REFER all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any 
way, such as power supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, 
the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
DO NOT expose the apparatus to dripping and splashing. DO NOT put objects filled with liquids, such as vases, on the 
apparatus.
The MAINS plug or an appliance coupler shall remain readily operable.
The airborne noise of the Apparatus does not exceed 70dB (A).
Apparatus with CLASS I construction shall be connected to a MAINS socket outlet with a protective earthing connec­
tion.
To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.
Do not attempt to modify this product. Doing so could result in personal injury and/or product failure.
Operate this product within its specified operating temperature range.

This symbol indicates that dangerous voltage constituting a risk of electric shock is present within this unit.

This symbol indicates that there are important operating and maintenance instructions in the literature accom­
panying this unit.

Important Product Information
The equipment is intended to be used in professional audio applications.

Note: This device is not intended to be connected directly to a public internet network.
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EMC conformance to Environment E2: Commercial and Light Industrial. Testing is based on the use of supplied and recommended cable types. The use of 
other than shielded (screened) cable types may degrade EMC performance.

Changes or modifications not expressly approved by Shure Incorporated could void your authority to operate this equipment.

Industry Canada ICES-003 Compliance Label: CAN ICES-3 (B)/NMB-3(B)

Authorized under the verification provision of FCC Part 15B.

Please follow your regional recycling scheme for batteries, packaging, and electronic waste.

Dante is a registered trademark of Audinate Pty Ltd.

Information to the user
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC 
Rules. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 
with the manufacturer's instruction manual, may cause interference with radio and television reception.

Notice: The FCC regulations provide that changes or modifications not expressly approved by Shure Incorporated could void 
your authority to operate this equipment.

These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equip­
ment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruc­
tions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be de­
termined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and the receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

This device may not cause harmful interference.
This device must accept any interference received, including interference that may cause undesired operation.

The CE Declaration of Conformity can be obtained from: www.shure.com/europe/compliance

Authorized European representative:
Shure Europe GmbH
Global Compliance
Jakob-Dieffenbacher-Str. 12
75031 Eppingen, Germany
Phone: +49-7262-92 49 0
Email: info@shure.de
www.shure.com

This product meets the Essential Requirements of all relevant European directives and is eligible for CE marking.

The CE Declaration of Conformity can be obtained from Shure Incorporated or any of its European representatives. For contact 
information please visit www.shure.com
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